1. Instructions for using Adobe Reader
All FWF forms are compatible with Adobe Reader (Version 6.0 and higher), which can be
downloaded free of charge at http://get.adobe.com/reader/.
The fields to be completed can be highlighted in order to enable the user to identify them
more easily.

Instructions:





Open the file Application form.pdf (or National research partner.pdf, etc.)
In the menu bar, open the Edit menu and then choose the Preferences item (in Mac
OS, this item can be found in the Reader menu). A dialog box will then appear.
Choose Forms in the list box under Categories (on the left-hand side of the dialog
box).
In the area to the right, activate the check box "Show border hover color for fields"
under Highlight color. This action will highlight all fields in light blue. You can also
deactivate the check box if you do not wish to highlight the fields in the form. Below
the check box, you can also choose the highlight color for fields as desired. Click OK
to confirm your selection.

Navigating forms:
Keyboard: Use the Tab key to move forward from one field to the next, and SHIFT + Tab to
move backward to the previous field in the form.
Mouse: Simply click on the desired field.

Field types
The form contains various field types:
Text fields: These are fields in which you can enter any of the characters on your keyboard
(e.g., German title, Applicant, etc.)
Number fields: These are defined fields in which only numbers can be entered (e.g.,
percentages, codes for scientific disciplines, etc.)
Date fields: These fields only allow entries in the following date format: dd.mm.yyyy (e.g.,
date of birth, etc.)
Drop-down list boxes: These fields provide a limited number of options for you to choose
from. Click on the drop-down arrow at the right of the field in order to open the list and
choose the desired item (e.g., Funding application type, Sex, etc.).
Check box:
Mouse: Simply click on the check box.
Keyboard: The check box can be selected using the Tab key and activated using the Space
bar.

Saving/printing and merging multiple PDF forms
Under the File menu, choose the item Save as… in order to save the (partly) completed
form. Choose Print to print out the form. Please note that completed PDF forms are only
converted into (unchangeable) PDF files once they are output to a PDF printer. The
information entered in the fields will then be “static” and can no longer be edited. In general,
the size of the file is also reduced. In order to merge multiple PDF forms without losing data,
it is first necessary to convert each completed form into a separate PDF file.
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How to fill out the application form for International Cooperation Projects
The application package consists of the files Application form.pdf, National research
partner.pdf (where applicable) and the programme-specific data. Another form is available for
the entry of co-authors and should be submitted with the application package in any case. If
there is no co-author, please simply submit an empty form.
A separate Excel file is provided for the breakdown of costs for a International Cooperation
Project. For information on how to fill out the Excel spreadsheet, please refer to page 6. For
international cooperation partners, please use the corresponding form.
In order to enter equipment requests, please use the "Equipment entry" sheet; in cases
where equipment previously funded by the FWF is transferred to a new project, please fill out
the "Equipment transfer" sheet.
Please read the instructions provided on the form carefully and note the explanations and
definitions provided below.

Application form: Page 1
Field name

Explanation

Funding application
type:

Choose "International Cooperation Project….." in the dropdown menu.

Call

Enter the full name of the call along with the corresponding
acronym in parentheses.

German and English
title

Please enter the title of the Austrian sub-project; if no such title
exists, then enter the title of the overall project.

Applicant

The applicant is also the coordinator or spokesperson for the
project.

Co-applicant

This programme does not provide for co-applicants, meaning that
this field does not need to be filled in.

Application form: Page 2
Field name

Explanation

Completion date of
doctoral studies

For medical studies: Date of completion of doctoral studies.

ORCID

See http://orcid.org/, starting with 01.01.2016 mandatory

Birth dates of
children

This field need not be filled in.

Highest academic
position/degree

Please choose the category which best describes the highest
position or degree you have attained. In this context, it is
necessary to distinguish between your academic position/degree
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and your actual current activities, which are covered in the next
question. Should none of the categories match your
position/degree, please describe it as specifically as possible in
the "Other" field (maximum: 60 characters including spaces).
Highest current
professional position

Please choose the category which best describes your position.
This question refers to the highest professional position you
currently hold. In this context, it is necessary to distinguish
between your actual activities and your highest academic position
or degree, which was covered in the previous question. Should
none of the categories match your current professional position,
please describe it as specifically as possible in the "Other" field
(maximum: 60 characters including spaces).

Application form: Page 3
Field name

Explanation

Research institution

Please indicate the research institution at which the project is to
be carried out.

Mailing address

These address fields only need to be filled out in cases where the
applicant does not have a postal address at a research institution.
The applicant's name will be entered automatically and cannot be
deleted.

Application form: Page 4
Field name

Explanation

Percentage of
requested funding to
be consumed at the
research institution

This percentage refers exclusively to the allocation of funds
requested from the FWF to the applicant's research institution and
to that of any other research partner in Austria. Funds requested
from partner organizations abroad are not considered relevant
here.

Share of work time
(%)

Percentage of overall work time (teaching, research, administrative
tasks, etc.) which will be spent on the project.

Project keywords

Please enter a maximum of six keywords in English which describe
your project as completely and as accurately as possible.

Scientific disciplines
to which project is
related

Using the six-digit codes defined by Statistics Austria (see
http://www.fwf.ac.at/en/ - application – Download application
forms), please indicate the main scientific discipline as well as a
maximum of three additional scientific disciplines to which your
project is related. In addition, please enter percentages to indicate
the extent to which each scientific discipline is involved in your
project. The percentages entered must total 100%.
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Programme specific data (page 8)
Field name

Explanation

ERA-NET calls or
other coordinated
programmes

"Coordinated programmes" include consortia with multiple
partners from different countries.

Role of applicant

In coordinated programmes, one of the partners acts as the
coordinator for the overall project ("project coordinator").
"National sub-project heads" are responsible for the various
national sub-projects within the overall project.

Joint Project

Joint Projects are generally bilateral research projects within the
framework of an agreement between the FWF and another
funding agency abroad.

Country and name of
funding agency
abroad

Please enter the full name of the funding agency abroad and
(where applicable) its abbreviation or short name in parentheses.

Name of international
project partner

Please provide the full name of your international project partner
(with the last name in CAPITAL LETTERS).

Joint Project (Lead
Agency procedure)

Joint Projects under the Lead Agency procedure are generally
bilateral cooperation projects for which the application is reviewed
by one of the funding agencies involved (i.e., the "lead agency").

Name of international
project partner

Please provide the full name of your international project partner
(with the last name in CAPITAL LETTERS).

Lead agency

Please provide the name of the funding agency which will act as
the lead agency (indicating the agency's full name where
necessary).

Other funding
agencies involved

Please provide the names of any other funding agencies involved
(indicating the agencies' full names where necessary).

Programme specific data (page 9)
Field name

Explanation

Data entry sheet for
international cooperation
partners

Please fill in all relevant international cooperation partner for
the project, regardless of whether or not the partner is to
receive funding from the project.
For coordinated programmes (ERA-Net Calls, etc.), it is
necessary to provide the names of each national sub-project
head and the coordinator as well as any other individual
cooperation partners relevant to the Austrian sub-project.

Role of international
cooperation partner in

Please indicate the role of each international cooperation
partner.
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coordinated programmes
(ERA-Net calls, etc.)

In coordinated programmes, one of the partners acts as the
coordinator for the overall project ("project coordinator").
"National sub-project heads" are responsible for the various
national sub-projects within the overall project.
"Associated partners" are sub-project heads within the
consortium whose national funding agencies do not participate
in the programmes in question.
"Individual cooperation partners" refer to additional and
directly relevant cooperation partners within the Austrian subproject.

Role of international
cooperation partner in
Joint Projects (or Joint
Projects under the Lead
Agency procedure)

In this context, international cooperation partners refer to
those who are to receive financing from the participating
funding agency or agencies abroad.
Individual cooperation partners refer to additional cooperation
partners directly relevant to the Austrian applicant's project.

The field only needs to be filled in if the international
Cooperation partners
from developing countries cooperation partner is to receive financial support from the
FWF project (and belongs to the category “Least Developed
Countries”, “Other Low Income Countries” and “Lower Middle
Income Countries and Territories”) according to the OECD’s
current DAC List (see DAC-Liste), with exception of countries
which have a cooperation agreement with FWF (currently
India).
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Instructions for filling out the "Breakdown of Costs" Excel spreadsheet:
Please enter the costs to be funded in the "Breakdown of Costs" spreadsheet.
The fields highlighted in light gray can be filled in. The subtotals and overall totals are
calculated automatically and cannot be changed. As parts of the spreadsheet are locked,
only certain functions can be used (e.g., insert/delete rows). It may be necessary to add rows
if you request funding for additional project personnel. If that is the case, please do the
following:


Select all of Row 7 or Row 8 by clicking on the row header.



Press the right mouse button and choose "Insert". This will insert an additional row
above Position No. 02 or 03. Repeat this procedure until the spreadsheet contains
the desired number of rows. You can also delete those rows by choosing "Delete".



It will then be necessary to ensure that the position numbers are numbered
consecutively (01, 02, etc.).

To save the breakdown of costs as a PDF file, please do the following:


Click on the "Office" button and choose the "Save as…" menu item.



Then choose PDF or XPS.



This will open a dialog box in which you can define the name of the file, then click
Publish.

In order to import the spreadsheet into a Word file, please do the following:


Launch Word and change the page layout to landscape format ("Page layout" tab /
"Orientation" button / "Landscape" option).



To insert the spreadsheet into the Word file, choose the "Insert" tab and the
"Object" button, then choose the "Insert object" function.



This will open a dialog box where you can choose the "Create from file" tab.



Then choose the desired file under "File name:" and click OK.

The breakdown of costs will then be imported into Word and can be integrated into
applications which are not subject to formal requirements.

Please also submit the file "Cost_Breakdown.xls" in electronic form along with the
other files.
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